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初识 Android 

 

一章概述了 Android 的历史，引出了本书其余部分将涉及的概念。现在你可能迫不及

待地想编写代码了。本章首先介绍使用 Android SDK 开发应用程序的前提条件，学习安装开发环

境。接下来，将逐步演示“ Hello World!” 应用程序，之后详细分析一个稍大型的应用程序。然后

将解释 Android 应用程序生命周期，最后简单讨论使用 AVD（Android Virtual Devices，Android

虚拟设备）调试应用程序。 

要为 Android 开发应用程序，需要 JDK（Java SE Development Kit，Java SE 开发工具包）、

Android SDK 和一个开发环境。严格来讲，可以使用简单的文本编辑器开发应用程序，但本书将

使用常见的 Eclipse IDE。Android SDK 需要 JDK 5 或更高版本（我们在示例中使用的是 JDK 6）

和 Eclipse 3.3 或更高版本（我们使用的是 Eclipse 3.5，也叫 Galileo）。本书使用 Android SDK 2.0。 

最后，为了使开发过程更加简单，需要使用 ADT。ADT 是一个 Eclipse 插件，支持使用 Eclipse 

IDE 开发 Android 应用程序。实际上，本书中的所有示例都是结合使用 Eclipse IDE 和 ADT 工具

开发的。 

上 

第 2 章 
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2.1 安装环境 

要开发 Android 应用程序，需要建立一个开发环境。本节将介绍如何下载 JDK 6、Eclipse IDE、

Android SDK 和 ADT，以及如何配置 Eclipse 来开发 Android 应用程序。 

Android SDK 兼容 Windows（Windows XP、Windows Vista 和 Windows 7）、Mac OS X（仅限

英特尔平台）和 Linux（仅限英特尔平台）。本章将展示如何为所有这些平台建立环境（对于 Linux，

我们仅介绍 Ubuntu 版本）。我们不会在其他章讨论与平台差异有关的细节。 

2.1.1 下载 JDK 6 

首先需要的是 JDK。Android SDK 需要 JDK 5 或更高版本，我们使用 JDK 6 来开发本书中的

示例。对于 Windows 来说，从 Sun 网站（http://java.sun.com/javase/downloads/）下载 JDK 6 并安

装。只需要 JDK，不需要其他程序包。对于 Mac OS X 来说，从苹果公司网站（http://developer. 

apple.com/java/download/）下载 JDK，选择适用于具体的 Mac OS 版本的文件，然后安装。要安

装 JDK for Linux，打开一个终端窗口并键入以下命令： 

 

sudo apt-get install sun-java6-jdk 

 

这将安装 JDK 及任何依赖关系，比如 JRE（Java Runtime Environment，Java 运行时环境）。 

接下来，设置 JAVA_HOME环境变量以指向 JDK 安装文件夹。在 Windows XP 机器上，可以转

到“ 开始” ➤“ 我的电脑”，右键单击并选择“ 属性”，选择“ 高级” 选项卡，然后单击“ 环境变

量”。单击“ 新建” 添加 JAVA_HOME变量，如果该变量已存在，单击“ 编辑” 修改它。JAVA_HOME

的值类似于 C:\Program Files\Java\jdk1.6.0_16。对于 Windows Vista 和 Windows 7，调出“ 环境变



22  第 2 章 初识 Android 

 

量” 屏幕的步骤稍有不同，转到“ 开始” ➤“ 计算机”，右键单击并选择“ 属性”，单击“ 高级系

统设置” 链接，然后单击“ 环境变量”。按照与 Windows XP 相同的指令更改 JAVA_HOME环境变量。

对于 Mac OS X，在 HOME目录的.profile 中设置 JAVA_HOME。编辑或创建.profile 文件，添加一行命

令，类似于： 

 

export JAVA_HOME=path_to_JDK_directory 

 

其中 path_to_JDK_directory 可能是/Library/Java/Home。对于 Linux，编辑.profile 文件并添

加与用于 Mac OS X 的命令类似的命令，但命令中的路径可能类似于/usr/lib/jvm/java-6-sun。 

2.1.2 下载 Eclipse 3.5 

安装 JDK 之后，可以下载 Eclipse IDE for Java Developers。（无需下载针对 Java EE 的版本，

它更大，而且包含本书不需要的内容。）本书中的示例使用 Eclipse 3.5（在 Windows 环境中）。所

有 Eclipse 版本都可以从 http://www.eclipse.org/downloads/下载。Eclipse 发布版是一个.zip 文件，

可以解压到任何位置。Windows 上最简单的解压位置就是 C:\，这会创建 C:\eclipse 文件夹，其中

包含 eclipse.exe。对于 Mac OS X，可以解压到 Applications 文件夹，在 Linux 上可以解压到 HOME

目录。对于所有平台，Eclipse 可执行程序都位于 eclipse 文件夹中。 

首次启动 Eclipse 时，它将要求为工作区提供一个位置。为了简化操作，可以选择一个简单的

位置，比如 C:\android。如果将计算机与其他人共享，应该将工作区文件夹放在 HOME文件夹中。 

2.1.3 下载 Android SDK 

要为 Android 开发应用程序，需要使用 Android SDK。该 SDK 包含一个模拟器，所以无需带
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有 Android 操作系统的移动设备就能够开发 Android 应用程序。实际上，本书中的示例都是在

Windows XP 机器上开发的。 

可以从 http://developer.android.com/sdk 下载 Android SDK。

Android SDK 以.zip 文件的形式发布，类似于 Eclipse 的发布方式，所

以需要将其解压到合适的位置。对于 Windows，将该文件解压到一

个方便的位置（我们使用了 C 盘），然后会得到一个类似 C:\android -sdk-windows 的文件夹，其

中将包含如图 2-1 所示的文件。对 Mac OS X 和 Linux，可以将文件解压到 HOME 目录。 

Android SDK 包含一个 tools 目录，需要将它添加到 PATH中。我们可以现在添加，如果正在

升级，则需要确保它是正确的。添加之后，还需要添加 JDK bin 目录，这会使以后的开发工作更

轻松。对于 Windows，返回到上面介绍的“ 环境变量” 窗口。编辑 PATH 变量，添加一个分号，

然后添加 Android SDK tools 文件夹的路径，接着添加另一个分号和%JAVA_HOME%\bin。完成之后

单击“ 确定”。对于 Mac OS X 和 Linux，编辑.profile 文件，将 Android SDK tools 目录路径添加

到 PATH变量，以及$JAVA_HOME/bin 目录。可以采用类似下面这样的命令： 

 

export PATH=$PATH:$HOME/android-sdk-linux_x86/tools:$JAVA_HOME/bin 
 

在本书后面，将会遇到需要执行命令行实用程序的情况。这些程序包含在 JDK 或 Android 

SDK 中。通过在 PATH 中包含这些目录，我们无需指定完整的参数就能够执行它们，但需要启动

一个命令行窗口来运行它们。后面的章节将介绍这个命令行窗口。在 Windows 中，创建命令行

窗口的最简单方式是单击“ 开始” ➤“ 运行”，键入 cmd，然后单击“ 确定”。对于 Mac OS X，

 

图 2-1 Android SDK 的内容 
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从 Finder 中的 Applications 文件夹或从 Dock（如果存在）中选择 Terminal。对于 Linux，从

Applications➤Accessories 菜单选择 Terminal。 

最后一点，尽管现在讨论的是不同平台之间的差异，但需要提醒的是，以后你可能需要知道

工作站的 IP 地址。为此，在 Windows 中，启动一个命令行窗口并输入命令 ipconfig。结果将包

含一个 IPv4 项（或类似项），它旁边列出了 IP 地址。IP 地址类似于 192.168.1.25。对于 Mac OS X

和 Linux，启动一个命令行窗口并使用命令 ifconfig。在一个名为“ inet addr” 的标签旁边可以

找到 IP 地址。可能会看到一个名为“ localhost” 或“ lo” 的网络连接，此网络连接的 IP 地址为

127.0.0.1。这是操作系统所使用的一个特殊网络连接，与工作站的 IP 地址不同。工作站的 IP 地

址可不是这样的。 

2.1.4 安装 ADT 

现在需要安装 ADT，这个 Eclipse 插件对开发 Android 应用程序有很大帮助。具体来讲，ADT

与 Eclipse 集成，提供了一些工具来创建、测试和调试 Android 应用程序。需要使用 Eclipse 中的

Install New Software 工具来执行安装。如果正在升级 ADT，请参考这些安装说明之后的说明。首

先启动 Eclipse IDE 并执行以下步骤。 

(1) 选择 Help 菜单项并选择 Install New Software…选项。这个选项在以前的 Eclipse 版本中为

“ Software Updates”。 

(2) 选择“ Work with” 字段，键入 https://dl-ssl.google.com/android/eclipse/并按回车键。Eclipse

将连接该网站并生成列表，如图 2-2 所示。 
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(3) 应该会看到一个名为 Developer Tools的项，它包含两个子节点：Android DDMS和 Android 

Development Tools。选择父节点 Developer Tools，并确认同时选中了两个子节点，然后单击 Next

按钮。你看到的版本可能比上图中显示的版本新，这很正常。 

(4) Eclipse 现在要求验证要安装的两个工具。再次单击 Next。 

(5) 现在 Eclipse 将要求查看 ADT 和安装 ADT 所需工具的许可协议。查看许可协议，单击“ I 

accept...”，然后单击 Finish 按钮。 

Eclipse 将下载 ADT 并安装。安装完成之后需要重新启动 Eclipse，新插件才会在 IDE 中显示。 

 

图 2-2 使用 Eclipse 中的 Install New Software 功能安装 ADT 

如果 Eclipse 中已有一个旧版 ADT，转到 Eclipse Help 菜单并选择 Check for Updates。应该会

看到新版的 ADT，然后执行上面的安装说明中第(3)步及以后的步骤。 

在 Eclipse 中安装 ADT 的最后一步是将它指向 Android SDK。选择 Window 菜单并选择
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Preferences。（在 Mac OS X 上，Preferences 位于 Eclipse 菜单下。）在 Preferences 对话框中，选择

Android 节点并将 SDK Location 字段设置为 Android SDK 的路径（参见图 2-3），然后单击 Apply

按钮。注意，可能会看到一个对话框，询问是否希望将与 Android SDK 相关的使用统计数据发送

给 Google。可以随意选择。单击 OK 关闭 Preferences 窗口。 

 

图 2-3 将 ADT 指向 Android SDK 

安装 Android SDK 之初，不会显示任何平台版本。如果显示了，在设置 SDK Location 之后，

将会在图 2-3 所示的 Android Preferences 窗口中看到它们。安装平台非常简单。在 Eclipse 中，转

到 Window ➤ Android SDK and AVD Manager ， 选 择 Available Packages ， 选 择

https://dl-ssl.google.com/android/repository/repository.xml 源，然后选择想要的平台和附加项（比如

Android 2.0）。参见图 2-4。 
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图 2-4 向 Android SDK 添加平台 

单击 Install Selected。安装每一项时都需要单击 Accept，然后单击 Install Accepted。ADT 然

后将下载包和平台，使它们在 Eclipse 中可用。Google API 是一些附加项，用于开发 Google Maps

以使用应用程序。单击此窗口左侧的 Installed Packages，可以看到已安装的平台。 

现在基本上已准备好开发第一个 Android 应用程序了。但是首先，我们必须简单介绍一下

Android 应用程序的基本概念。 

2.2 了解基本组件 

每个应用程序框架都有一些关键组件，在开始编写基于该框架的应用程序之前，开发人员必

须理解这些组件。例如，为了编写 J2EE 应用程序，可能需要理解 JSP（JavaServer Pages）和 Servlet。

类似地，要为 Android 开发应用程序，需要理解 Activity、View、Intent、ContentProvider、Service

和 AndroidManifest.xml 文件。下面将简要介绍这些基本概念，后面各章将更详细地介绍它们。 

2.2.1 View 

View是 UI 元素，是构成用户界面的基本构建块。View是分层的，它们知道如何绘制自身。
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View 可以是一个按钮、标签或文本字段，或者各种其他 UI 元素。如果熟悉 J2EE 和 Swing 中的

View，那么就会理解 Android 中的 View。 

2.2.2 Activity 

Activity 是一个用户界面的概念。Activity 通常表示应用程序中的一个屏幕。它通常包含

一个或多个 View，但也可以不包含 View。Android 中的其他概念可以更好地表示无 View 的

Activity（在 2.2.5 节将会看到）。 

2.2.3 Intent 

Intent通常定义执行某种工作的“ 意图”。Intent封装了几种概念，所以理解它们的最佳方

法就是查看它们的使用示例。可以使用 Intent来执行以下任务。 

 广播消息 

 启动 Service 

 启动 Activity 

 显示网页或一组联系人 

 拨出或接听电话 

Intent 并不总是由应用程序发起，系统也会使用它们来向应用程序传递特定的事件（比如

收到一条文本消息）。 

Intent 可以是显式的，也可以是隐式的。如果只是希望显示一个 URL，那么系统将会决定

哪些组件能满足此意图。你也可以提供由什么来处理该意图的具体信息。Intent将操作和操作处
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理程序松散地连接在一起。 

2.2.4 ContentProvider 

我们常常需要在设备上的移动应用程序之间共享数据。因此，Android 为应用程序定义了一

种标准机制来共享数据（比如联系人列表），无需公开底层存储、结构和实现。通过

ContentProvider可以公开数据，允许应用程序使用来自其他应用程序的数据。 

2.2.5 Service 

Android 中的 Service类似于 Windows 或其他平台中的服务，它们都是可能长时间运行的后

台进程。Android 定义了两种类型的 Service：本地 Service和远程 Service。本地 Service是只

能由承载该 Service的应用程序访问的组件。而远程 Service是供在设备上运行的其他应用程序

远程访问的 Service。 

电子邮件应用程序用于轮询新邮件的组件，就是一个 Service示例。如果这种 Service不能

被在设备上运行的其他应用程序使用，那么它就是本地 Service。如果有多个应用程序使用该

Service，那么它就是远程 Service。在第 8 章讨论 startService()和 bindService()的时候将会

看到二者的区别。 

可以使用现有 Service，也可以扩展 Service类来编写自己的 Service。 

2.2.6 AndroidManifest.xml 

AndroidManifest.xml 类似于 J2EE 中的 web.xml 文件，它定义应用程序的内容和行为。例如，

它列出应用程序的 Activity和 Service，以及运行应用程序所需的权限。 
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2.2.7 AVD 

AVD 使开发人员无需使用 Android 手机就可以测试应用程序。可以在各种配置下创建 AVD

来模拟不同类型的手机。 

2.3 Hello World! 

现在可以编写第一个 Android 应用程序了。首先编写一个简单的“ Hello World!” 程序。执行

以下步骤来创建应用程序的框架。 

(1) 启动 Eclipse 并选择 File➤New➤Project。在 New Project 对话框中，选择 Android，然后

单击 Next。然后将看到 New Android Project 对话框，如图 2-5 所示。Eclipse 可能已将“ Android 

Project” 添加到 New菜单中，如果存在此菜单项，则可以使用它。工具栏上还有一个 New Android 

Project 按钮可供使用。 

(2) 如图 2-5 所示，输入 HelloAndroid 作为项目名称，HelloAndroidApp 作为应用程序名称，

com.androidbook 作为包名称，HelloActivity 作为 Create Activity 的名称。注意，对于真实的应用

程序，将需要使用有意义的应用程序名称，因为它将在应用程序的标题栏中显示。另外请注意，

项目的默认位置将在 Eclipse 工作区目录下。在本例中，Eclipse 工作区位置为 c:\android，New 

Project Wizard 将新应用程序名称附加到工作区位置之后，形成 c:\android\HelloAndroid\。最后，

Min SDK Version 值 4 告诉 Android，应用程序需要 Android 1.6 或更新版本。 
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图 2-5 使用 New Project Wizard 创建 Android 应用程序 

(3) 单击 Finish 按钮，这将告诉 ADT 生成项目框架。现在，打开 src 文件夹下的 HelloActi- 

vity.java 文件，将 onCreate()方法修改为： 

 

/** Called when the activity is first created. */ 

    @Override 

    public void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        /** create a TextView and write Hello World! */ 

        TextView tv = new TextView(this); 

        tv.setText("Hello World!"); 

        /** set the content view to the TextView */ 

        setContentView(tv); 

    } 

Eclipse 会自动为 android.widget.TextView 添加一条 import 语句。可能需要单击第一个

import语句旁边的“ +” 号来查看所有导入语句。如果没有自动添加该导入语句，请自行添加。

保存 HelloActivity.java 文件。 
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要运行应用程序，需要创建一个 Eclipse 启动配置，还需要一个虚拟设备来运行应用程序。

我们将简单介绍一下这些步骤，以后再详细地介绍 AVD。要创建 Eclipse启动配置，执行以下步骤。 

(1) 选择 Run➤Run Configurations。 

(2) 在 Run Configurations 对话框中，双击左侧窗格中的 Android Application。向导将插入一

个名为 New Configuration 的新配置。 

(3) 将配置重命名为 RunHelloWorld。 

(4) 单击 Browse…按钮，选择 HelloAndroid 项目。 

(5) 在 Launch Action 下，选择 Launch，然后从下拉列表中选择 com.androidbook.HelloActivity。

弹出的对话框如图 2-6 所示。 

 

图 2-6 创建 Eclipse 启动配置来运行“ Hello World!” 应用程序 
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(6) 单击 Apply，然后单击 Run。基本上完成了。Eclipse 已准备好运行应用程序，但它需要

一个运行应用程序的设备。如图 2-7 所示，Eclipse 会警告没有找到兼容的目标设备，并询问是否

希望创建一个。单击 Yes。 

 

图 2-7 Eclipse 警告没有兼容目标设备并询问是否创建新 AVD 

(7) 弹出的窗口中将显示现有的 AVD（参见图 2-8）。注意，这与图 2-4 所示的窗口相同。需

要添加一个适合新应用程序的 AVD。单击 New 按钮。 

 

图 2-8 现有的 Android 虚拟设备（目前还没有） 

(8) 按图 2-9 所示填写 Create new AVD 表单。将 Name 设置为 DefaultAVD，选择 Android 2.0 - 
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API Level 5 作为 Target，将 SD Card 的大小设置为 32（32 MB）。对于 Skin，保留默认的 HVGA。

单击 Create AVD。Eclipse 将确认成功创建了 AVD。单击 OK 关闭 Android SDK 窗口。 

说明 我们为AVD选择了一个较新的SDK版本，但我们的应用程序也可以在较老的版本上运行。

这之所以可行，是因为具有较新SDK的AVD可以运行需要较老SDK版本的应用程序。当

然，反过来是行不通的：需要较新SDK的应用程序无法在具有较老SDK的AVD上运行。 

(9) 最后，从底部列表中选择新的 AVD。注意，可能需要单击 Refresh 按钮，才能在列表中

显示新 AVD。单击 OK 按钮。 

 

图 2-9 配置 Android 虚拟设备 



2.3 Hello World!  35 

 

1 

2 

3 

 

4 

6 

9 

10 

7 

5 

8 

(10) Eclipse 将启动模拟器①，并在其中安装运行你的第一个 Android 应用程序。 

说明 模拟器可能需要1分钟来模拟设备启动过程。启动之后，应该会看到HelloAndroidApp正在

模拟器中运行，如图2-10所示。此外，请注意，在启动过程中，模拟器在后台启动了其

他应用程序，所以有时会看到警告或错误消息。如果看到错误消息，通常可以忽略，让

模拟器进入启动过程中的下一步。例如，如果运行模拟器并看到消息“ application abc is not 

responding”，可以等待该应用程序启动，也可以告诉模拟器强制关闭该应用程序。通常

应该等待，让模拟器干净地启动。 

现在你掌握了如何创建新 Android 应用程序和在模拟器中运行它。接下来，我们将更详细地

介绍 ADV，然后深入剖析 Android 应用程序的元素和结构。 

                                                           

① 初次启动模拟器可能要几分钟时间，读者务必耐心等待。具体时间因开发机器配置可能会有差异。启动模拟器后，

下次测试应用的速度会提高。——编者注 
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图 2-10 HelloAndroidApp 正在模拟器中运行 

2.4 AVD 

AVD 表示一种设备配置。例如，可以用一个 AVD 来表示一个运行 1.5 版 SDK 且具有 32 MB 

SD 卡的较老的 Android 设备。使用 AVD 的理念是，首先创建将要支持的 AVD，然后在开发和测

试应用程序时，将模拟器指向其中一个 AVD。指定（和更改）要使用的 AVD 非常简单，这使应

用各种配置进行测试也非常简单。前面介绍了如何使用 Eclipse 创建 AVD。可以在 Eclipse 中创建

更多 AVD，只需打开 Window➤Android SDK and AVD Manager，单击左侧的 Virtual Devices。 

也可以使用命令行创建 AVD，要通过命令行创建 AVD，需要使用 tools 目录（c:\android-sdk- 

windows\tools\）下一个名为 android 的批处理文件。android 可用于创建新 AVD 和管理现有 AVD。

例如，可以查看现有 AVD、移动 AVD，等等。运行 android–help，可以看到 android 的各种使



2.4 AVD  37 

 

1 

2 

3 

 

4 

6 

9 

10 

7 

5 

8 

用选项。现在我们就来创建一个 AVD。 

默认情况下，AVD 存储在 HOME 目录（所有平台）下一个名为.android\AVD 的文件夹中。

如果为上面的“ Hello World!” 创建了一个 AVD，那么可以在这里找到它。如果希望在其他地方

存储或修改 AVD，也没有问题。对于本示例，我们创建一个文件夹来存储 AVD 映像，比如 c:\avd\。

下一步是运行 android 文件来创建该 AVD。打开一个命令行窗口并键入以下命令（使用合适的路

径来存储工作站的 AVD 文件，并根据所安装的老 SDK 平台，使用合适的 t参数的值）： 

 

android create avd -n OlderAVD -t 2 -c 32M -p C:\AVD\OlderAVD\  

 

传递给批处理文件的参数如表 2-1 所示。 

表2-1 传递给android.bat工具的参数 

参数/命令 描  述 

create avd 
告诉该工具创建一个AVD 

n 
AVD的名称 

t 
目标运行时 

使用1表示Android 1.1，2表示Android 1.5，3表示Android 1.6等 

c 
SD卡的大小（以字节为单位）。使用K或M表示KB或MB 

p 
生成的AVD的路径。此参数是可选的 

执行上面的命令将生成一个 AVD，应该会看到类似于图 2-11 所示的输出。注意，当运行

create avd 命令时，系统会询问是否希望创建自定义硬件配置文件。我们现在选择 No，但是应

该知道如果回答 Yes，系统将提示设置 AVD 的各种选项，比如屏幕大小、是否有照相机，等等。 
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图 2-11 创建一个 AVD 会生成此 android.bat 输出 

即使使用 android.bat 程序为 OlderAVD 指定了一个替代位置，HOME 目录的.android/AVD 文

件夹下仍然有一个OlderAVD.ini文件。这是好事，如果返回到Eclipse，选择Window➤Android SDK 

and AVD Manager，将会看到所有 AVD，在 Eclipse 中运行 Android 应用程序时将能够访问它们。 

回头再看一下图 2-5。对于我们的“ Hello World!” 应用程序，我们选择使用 Android 1.6，将

Min SDK Version 设置为 4。如果选择 Android 1.5（假设已经安装），Min SDK Version 应设置为 3。

对于 Android 2.0，Min SDK Version 设置为 5。 

另请注意，如果在 SDK Target 列表中选择 Google APIs，将包含应用程序中的映射功能，而

选择Android 1.5或更新版本，将不包含此功能。在SDK 1.5以前的版本中，映射类包含在android.jar

中，但自该版本起，它们转移到了一个独立的.jar 文件 maps.jar 中。当选择 Google APIs时，Min SDK 

Version 默认设置为 5（对应于 Android 2.0）或 4（对应于 Android 1.6）等，ADT 插件将包含项

目中的 maps.jar 文件。换言之，如果开发的应用程序使用了与映射相关的类，你将希望将 SDK 

Target 设置为 Google APIs。注意，仍然需要向 AndroidManifest.xml 文件添加映射使用库
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（<uses-libraryandroid:name="com.google.android.maps"/>）项，第 7 章将对此进行详细介绍。 

2.5 剖析 Android 应用程序的结构 

尽管各种 Android 应用程序的大小和复杂性可能相差甚大，但它们的结构是类似的。图 2-12

展示了刚构建的“ Hello World!” 应用程序的结构。 

 

图 2-12 “ Hello World!” 应用程序的结构 

Android 应用程序除了包含必需的元素外，还包含一些可选元素。表 2-2 总结了 Android 应用

程序中的元素。 

表2-2 Android应用程序的元素 

元  素 描  述 是否必需 

AndroidManifest.xml 
Android应用程序描述文件。此文件定义应用程序的 Activity、

ContentProvider、Service和 Intent 接收者。也可以使用此文件以声明方

式定义应用程序所需的权限，以及将特定权限授予使用该应用程序的

Service的其他应用程序。而且，该文件可以包含可用于测试该应用程序

或其他应用程序的工具细节 

是 
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src 
文件夹，包含应用程序的所有源代码 是 

assets 
任意文件夹和文件集合 否 

res 
文件夹，包含应用程序的资源。这是drawable、anim、layout、menu、

values、xml和raw的父文件夹 

是 

drawable 
文件夹，包含应用程序所使用的图像或图像描述符文件 否 

anim 
文件夹，包含描述应用程序所使用的动画的XML描述符文件 否 

layout 
文件夹，包含应用程序的View。应该使用XML描述符创建应用程序的

View，而不是对它们进行编码 

否 

menu 
文件夹，包含应用程序中的菜单的XML描述符文件 否 

（续） 

元  素 描  述 是否必需 

values 
文件夹，包含应用程序使用的其他资源。该文件夹中的所有资源也是

使用XML描述符定义的。此文件夹中的资源示例包括字符串、样式和颜色 

否 

xml 
文件夹，包含应用程序使用的其他XML文件。 否 

raw 
文件夹，包含应用程序必需的其他数据——可能是非XML数据。 否 

从表 2-2 可以看出，Android 应用程序主要由 3 部分组成：应用程序描述文件、各种资源的

集合，以及应用程序源代码。如果暂时撇开 AndroidManifest.xml 文件，可以通过一种简单的方式

来看待 Android 应用程序：代码实现业务逻辑，其他一切都是资源。这种基本结构类似于 J2EE

应用程序的基本结构，其中资源对应于 JSP，业务逻辑对应于 servlet，AndroidManifest.xml 文件

对应于 web.xml 文件。 

也可以将 J2EE 的开发模型与 Android 的开发模型进行比较。在 J2EE 中，使用标记语言来构

建 View。Android 也采用了这种方法，但 Android 中的标记语言是 XML。这种方法非常好，你无

需硬编码应用程序的 View，可以通过编辑标记来修改应用程序的外观。 

另外，一些与资源相关的限制也值得注意。首先，Android 仅支持在 res 下创建预定义文件
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夹，而且预定义文件夹下不能嵌套其文件夹。例如，它不支持 layout 文件夹（或 res 下的其他预

定义文件夹）下的嵌套文件夹。其次，assets 文件夹与 res 下的 raw 文件夹具有很多相似性。两个

文件夹都包含原始文件，但 raw中的文件被当做资源，而 assets 中的文件不是。所以 raw中的文

件可以本地化，可以通过资源 ID 访问，但 assets 文件夹的内容被视为通用内容，对它们的使用

没有资源限制，不需要提供支持。注意，由于 assets 文件夹的内容未被当做资源，所以可以在其

中随意建立文件夹和文件。（第 3 章将更详细地介绍资源。） 

说明 你可能已注意到，Android大量使用了XML。我们都知道，XML是一种臃肿的数据格式，

所以我们不禁质疑，在知道目标将是资源有限的设备时还采用XML有意义吗？事实上，

我们在开发期间创建的XML会使用AAPT（Android Asset Packaging Tool，Android资产打

包工具）编译为二进制文件。因此，当将应用程序安装在设备上时，设备上的文件将存

储为二进制形式。当在运行时需要某个文件时，将读取该文件的二进制形式，而不会将

其转换为XML。这为我们提供了两方面的优势，我们既可以使用XML，又不必担心占用

设备上的宝贵资源。 

2.6 分析 Notepad 应用程序 

现在你不仅学习了如何创建新 Android 应用程序并在模拟器中运行它，应该也对 Android 应

用程序的构成有所了解了。接下来，我们将看一下 Android SDK 附带的 Notepad 应用程序。Notepad

的复杂性介于“ Hello World!” 应用程序与成熟的 Android 应用程序之间，所以分析它的组件有助
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于实际了解 Android 开发。 

2.6.1 加载和运行 Notepad 应用程序 

本节将介绍如何将 Notepad 应用程序加载到 Eclipse IDE 中，并在模拟器中运行。在开始之

前，应该了解 Notepad 应用程序实现了几个用例。例如，用户可以创建新笔记、编辑现有笔记、

删除笔记、查看所创建的笔记列表，等等。当用户启动应用程序时，没有任何已保存的笔记，所

以用户会看到空的笔记列表。如果用户按下 Menu 键，应用程序将呈现一个操作列表，其中一个

操作允许用户添加新笔记。添加笔记之后，用户可以选择相应菜单选项来编辑或删除它。 

执行以下步骤，将 Notepad 示例应用程序加载到 Eclipse IDE 中。 

(1) 启动 Eclipse。 

(2) 选择 File➤New➤Project。 

(3) 在 New Project 对话框中，选择 Android➤Android Project。 

(4) 在 New Android Project 对话框中，在 Project name 框中键入 NotesList，选择“ Create project 

from existing sample”，然后在 Build Target 区域选择 Android 2.0，在 Samples 菜单中滚动到 Notepad

应用程序。注意，Notepad 应用程序位于前面下载的 Android SDK 的 platforms\android-2.0\samples

文件夹中。选择 Notepad 之后，对话框读取 AndroidManifest.xml 文件，预填充 New Android Project

对话框中的剩余字段（参见图 2-13）。  
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图 2-13 创建 NotePad 应用程序 

(5) 单击 Finish 按钮。 

现在应该会在 Eclipse IDE 中看到 NotesList 应用程序。如果看到 Eclipse 中报告了此项目的任

何问题，尝试使用 Eclipse 中的 Project 菜单的 Clean 选项来清除它们。要运行应用程序，可以创

建一个启动配置（像“ Hello World!” 应用程序中那样），或者可以用右键单击项目，选择 Run As，

然后选择 Android Application。这将启动模拟器并在其上安装 NotePad 应用程序。模拟器完成加

载之后（你将会看到模拟器屏幕中央显示了日期和时间），按下 Menu 按钮查看 Notepad 应用程序。

随意操作该应用程序几分钟，以便熟悉它。 
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2.6.2 分解应用程序 

现在分析一下应用程序的内容（参见图 2-14）。 

可以看到，应用程序包含多个.java 文件、一些.png 图像、3

个 View（在 layout 文件夹下），以及 AndroidManifest.xml 文件。

如果是一个命令行应用程序，我们应该首先找到包含 Main 方法

的类。那么 Android 中与 Main方法对应的是什么呢？ 

Android 定义了一个入口 Activity，也称为顶级 Activity。

如果查看 AndroidManifest.xml 文件，将会找到一个 Content- 

Provider和3个Activity。NotesList活动为操作android.intent. 

action.MAIN和类别 android.intent.category. LAUNCHER定义一

个 Intent 过滤器。当要求运行 Android 应用程序时，主机会加载

该应用程序并读取 AndroidManifest.xml 文件。然后使用其中的

Intent 过滤器查找并启动一个或多个 Activity，这个 Intent 过滤器具有 MAIN 操作和 LAUNCHER

类别，如下例所示： 

 

<intent-filter> 

    <action android:name="android.intent.action.MAIN" /> 

    <category ndroid:name="android.intent.category.LAUNCHER"/> 

</intent-filter> 

 

主机找到希望运行的 Activity后，必须将定义的 Activity解析为实际的类。为此，它要组

合根包名称和 Activity名称，在本例中组合的结果为 com.example.android.notepad.NotesList（参

 

图 2-14 Notepad 应用程序的内容 
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见代码清单 2-1）。 

代码清单 2-1 AndroidManfiest.xml 文件 

<manifest xmlns:android="http://schemas.android.com/apk/res/android" 

    package="com.example.android.notepad" 

> 

    <application android:icon="@drawable/app_notes" 

        android:label="@string/app_name" 

    > 

        <provider android:name="NotePadProvider" 

            android:authorities="com.google.provider.NotePad" 

        /> 

        <activity android:name="NotesList" android:label="@string/title_notes_list"> 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" /> 

                <category android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

            <intent-filter> 

                <action android:name="android.intent.action.VIEW" /> 

                <action android:name="android.intent.action.EDIT" /> 

                <action android:name="android.intent.action.PICK" /> 

                <category android:name="android.intent.category.DEFAULT" /> 

                <data android:mimeType="vnd.android.cursor.dir/vnd.google.note" /> 

            </intent-filter> 

            <intent-filter> 

                <action android:name="android.intent.action.GET_CONTENT" /> 

                <category android:name="android.intent.category.DEFAULT" /> 

                <data android:mimeType="vnd.android.cursor.item/vnd.google.note" /> 

            </intent-filter> 

        </activity> 

… 

</manfiest> 

 

应用程序的根包名称定义为 AndroidManifest.xml 文件中<manifest>元素的一个特性

（attribute），而每个 Activity都有一个 name特性。 

确定了入口 Activity以后，主机将启动该 Activity并调用 onCreate()方法。让我们看一下

NotesList.onCreate()，如代码清单 2-2 所示。 

代码清单 2-2 onCreate方法 

public class NotesList extends ListActivity { 

  @Override 

  protected void onCreate(Bundle savedInstanceState) { 

          super.onCreate(savedInstanceState); 
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          setDefaultKeyMode(DEFAULT_KEYS_SHORTCUT); 

          Intent intent = getIntent(); 

          if (intent.getData() == null) { 

              intent.setData(Notes.CONTENT_URI); 

          } 

 

          getListView().setOnCreateContextMenuListener(this); 

           

          Cursor cursor = managedQuery(getIntent().getData(),  

  PROJECTION, null, null, 

                  Notes.DEFAULT_SORT_ORDER); 

 

          SimpleCursorAdapter adapter = new SimpleCursorAdapter(this,  

  R.layout.noteslist_item, cursor, new String[] { Notes.TITLE },  

  new int[] { android.R.id.text1 }); 

          setListAdapter(adapter); 

  } 

} 

 

Android 中的 Activity通常以一个 Intent启动，一个 Activity可以启动另一个 Activity。

onCreate()方法检查当前 Activity 的 Intent 是否有数据（笔记）。如果没有数据，它设置 URI

来获取 Intent上的数据。第 3 章将介绍 Android 通过操作 URI 的 ContentProvider来访问数据。

在本例中，URI 提供了足够的信息来从数据库检索数据。在 Notepad.java 中，常量 Notes.CONTENT_ 

URI被定义为 static final： 

 

public static final Uri CONTENT_URI =  

         Uri.parse("content://" + AUTHORITY + "/notes"); 

 

Notes类是 Notepad类的一个内部类。现在只需知道前面的 URI 告诉 ContentProvider获取

所有笔记即可。如果 URI 类似于以下形式： 

 

public static final Uri CONTENT_URI =  

      Uri.parse("content://" + AUTHORITY + "/notes/11"); 

 

那么所使用的ContentProvider将返回 ID等于11的笔记。第3章将深入讨论ContentProvider

和 URI。 

NotesList类扩展了 ListActivity类，它知道如何显示列表类型数据。列表中的项由一个内
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部 ListView（一个 UI 组件）管理，该组件负责显示列表中的笔记。在 Activity 的 Intent 上设

置了 URI 之后，Activity 将注册以便为笔记构建上下文菜单。如果你已经使用了该应用程序，

你应该会注意到，上下文菜单项将根据你的选择变化。例如，如果选择一个已经存在的笔记，应

用程序将显示“ Edit note” 和“ Edit title”。类似地，如果没有选择笔记，应用程序将显示“ Add note”

选项。 

接下来可以看到，Activity 执行了一个托管查询，获得结果的 Cursor 对象。托管查询是指

Android 将管理返回的 Cursor 对象。作为管理 Cursor 对象的一部分，如果必须卸载或重新加载

应用程序，应用程序和 Activity都不必担心定位 Cursor对象、加载它或卸载它。managedQuery()

的参数（如表 2-3 所示）非常有趣。 

表2-3 Activity.managedQuery()的参数 

参  数 数据类型 描  述 

URI Uri 
ContentProvider的URI 

projection String[] 
要返回的列（列名称） 

selection String 
可选的where子句 

selectionArgs String[] 
要选择的参数，前提是查询包含? 

sortOrder String 
要对结果集使用的排序方式 

本节后面和第 3 章将探讨 managedQuery()和 query()。现在只需知道 Android 中的查询返回

表列数据即可。projection 参数可用于定义你感兴趣的列。也可以精减整个结果集并使用 SQL 

order-by 子句（比如 asc 或 desc）排序结果集。另请注意，Android 查询必须返回一个名为_ID

的列，以支持检索单条记录。而且，必须知道 ContentProvider返回的数据类型——每一列是包
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含 string、int、binary还是其他类型的数据。 

执行查询后，返回的 Cursor对象将传递给 SimpleCursorAdapter的构造函数，后者将数据集

中的记录与用户界面（ListView）中的项相匹配。我们仔细看一下传递给 SimpleCursorAdapter

的构造函数的参数： 

 

    SimpleCursorAdapter adapter = 

 new SimpleCursorAdapter(this, R.layout.noteslist_item,  

cursor, new String[] { Notes.TITLE }, new int[] { android.R.id.text1 }); 

 

特别看一下第二个参数：一个 View 标识符，该 View 表示 ListView 中的项。在第 3 章将会

看到，Android 提供了一个自动生成的实用程序类，它提供了对项目中资源的引用。此实用程序

类称为 R 类，因为它名为 R.java。当编译项目时，AAPT 根据在 res 文件夹中定义的资源生成 R

类。例如，可以将所有字符串资源放在 values 文件夹中，这样 AAPT 将为每个字符串生成一个

public static标识符。Android 通常支持对所有资源执行此操作。例如，在 SimpleCursorAdapter

的构造函数中，NotesList活动传入了显示笔记列表项的 View 的标识符。此实用程序类的好处是

不必硬编码资源，而且可以进行编译时引用检查。换句话说，如果删除了一个资源，R类将会失

去对它的引用，引用该资源的任何代码都不会通过编译。 

下面看一下前面提到的 Android 中的另一个重要概念：NotesList的 onListItemClick()方法

（参见代码清单 2-3）。 

代码清单 2-3 onListItemClick方法 

@Override 

    protected void onListItemClick(ListView l, View v, int position, long id) { 

        Uri uri = ContentUris.withAppendedId(getIntent().getData(), id); 
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        String action = getIntent().getAction(); 

        if (Intent.ACTION_PICK.equals(action) ||  

Intent.ACTION_GET_CONTENT.equals(action)) { 

            setResult(RESULT_OK, new Intent().setData(uri)); 

        } else { 

            startActivity(new Intent(Intent.ACTION_EDIT, uri)); 

        } 

    } 

 

当用户在UI中选择一个笔记时，将调用onListItemClick()方法。该方法演示了一个Activity

启动另一个 Activity。当选择一个 Activity时，该方法创建一个 URI，方法是使用其 URI 并附

加上所选笔记的 ID。该 URI 然后会通过一个新 Intent传递给 startActivity()。startActivity()

是一种启动 Activity的方法：它启动一个 Activity，但在完成之后不会报告该 Activity的结果。

启动 Activity 的另一种方法是使用 startActivityForResult()。使用该方法，可以启动另一个

Activity并注册一个回调，以供 Activity完成时使用。例如，如果希望在一个 Activity完成之

后得到一个联系人的信息，那么需要使用 startActivityForResult()启动该 Activity 来选择该

联系人。 

现在，你可能想了解与 Activity相关的用户交互。例如，如果正在运行的 Activity启动了

另一个 Activity，而后者又启动了另一个 Activity，等等，那么用户可以处理哪个 Activity？

他可以同时操作所有 Activity吗，或者说他是否仅能操作一个 Activity？实际上，Activity有

一个既定的生命周期。它们保存在一个 Activity栈中，正在运行的 Activity位于栈的顶部。如

果正在运行的 Activity启动了另一个 Activity，那么第一个运行的 Activity将在栈中向下移动，

新的 Activity将位于栈顶部。栈中位置靠下的 Activity处于“ 暂停” 或“ 停止” 状态。暂停的

Activity 部分或完全对用户可见，停止的 Activity 对用户不可见。如果系统认为其他地方需要
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资源，它可以结束暂停或停止的 Activity。 

现在看一下数据持久性。用户创建的笔记保存在设备上真实的数据库中。具体来讲，Notepad

应用程序的后备存储是一个 SQLite 数据库。前面讨论的 managedQuery()方法最终将通过

ContentProvider处理数据库中的数据。让我们看一下传递给 managedQuery()的 URI 如何触发对

SQLite 数据库的查询。回想一下，传递给 managedQuery()的 URI 如下： 

 

public static final Uri CONTENT_URI =  

Uri.parse("content://" + AUTHORITY + "/notes"); 

 

内容 URI 始终具有如下形式：content://，后跟授权，然后是一个常规部分（取决于具体的上

下文）。因为 URI 不包含实际的数据，所以它会以某种形式引发对生成数据的代码的执行。这其

中有何联系？URI 引用如何解析为生成数据的代码？URI 是 HTTP 服务还是 Web 服务？实际上，

URI 或 URI 的授权部分在 AndroidManifest.xml 文件中配置为 ContentProvider： 

 

<provider android:name="NotePadProvider" 

     android:authorities="com.google.provider.NotePad"/> 

 

当 Android 看到一个需要解析的 URI 时，它获取该 URI 的授权部分并查找为该授权配置的

ContentProvider类。在 Notepad 应用程序中，AndroidManifest.xml 文件包含一个 NotePadProvider

类，该类是为 com.google.provider.NotePad授权配置的。代码清单 2-4 给出了该类的一小部分。 

代码清单 2-4 NotePadProvider类 

public class NotePadProvider extends ContentProvider 

{ 

 

    @Override 

    public Cursor query(Uri uri, String[] projection, String selection, 

 String[] selectionArgs,String sortOrder) {} 

 

    @Override 

    public Uri insert(Uri uri, ContentValues initialValues) {} 
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    @Override 

    public int update(Uri uri, ContentValues values, String where,  

String[] whereArgs) {} 

 

    @Override 

    public int delete(Uri uri, String where, String[] whereArgs) {} 

 

    @Override 

    public String getType(Uri uri) {} 

 

    @Override 

    public boolean onCreate() {} 

 

 

    private static class DatabaseHelper extends SQLiteOpenHelper {} 

 

    @Override 

        public void onCreate(SQLiteDatabase db) {} 

 

        @Override 

        public void onUpgrade(SQLiteDatabase db,  

int oldVersion, int newVersion) { 

            //... 

        } 

    } 

} 

 

NotePadProvider类扩展了 ContentProvider类。ContentProvider类定义了 6 个抽象方法，

其中 4 个是 CRUD（创建、读取、更新和删除）操作。另外两个抽象方法是 onCreate()和 getType()。

onCreate()在首次创建 ContentProvider 时调用。getType()提供了结果集的 MIME 类型（第 3

章将介绍 MIME 类型的工作原理）。 

关于 NotePadProvider类，另一个有趣的地方是内部的 DatabaseHelper类，它扩展了 SQLite- 

OpenHelper类。这两个类一起负责初始化、打开和关闭 Notepad 数据库，以及执行其他数据库任

务。有趣的是，DatabaseHelper类只有几行自定义代码（参见代码清单 2-5），SQLiteOpenHelper

类的 Android 实现执行了大部分任务。 

代码清单 2-5 DatabaseHelper类 
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private static class DatabaseHelper extends SQLiteOpenHelper { 

 

        DatabaseHelper(Context context) { 

            super(context, DATABASE_NAME, null, DATABASE_VERSION); 

        } 

 

        @Override 

        public void onCreate(SQLiteDatabase db) { 

            db.execSQL("CREATE TABLE " + NOTES_TABLE_NAME + " (" 

                    + Notes._ID + " INTEGER PRIMARY KEY," 

                    + Notes.TITLE + " TEXT," 

                    + Notes.NOTE + " TEXT," 

                    + Notes.CREATED_DATE + " INTEGER," 

                    + Notes.MODIFIED_DATE + " INTEGER" 

                    + ");"); 

        } 

 

        //… 

} 

 

如代码清单 2-5 所示，onCreate()方法创建了 Notepad 表。请注意，该类的构造函数使用

Notepad 表的名称调用了超类的构造函数。只有在数据库中不存在该表时，超类才会调用

onCreate()方法。另请注意，Notepad 表中包含在本节前面讨论的_ID列。 

现在看一个 CRUD 操作：insert()方法（参见代码清单 2-6）。 

代码清单 2-6 insert()方法 

//… 

SQLiteDatabase db = mOpenHelper.getWritableDatabase(); 

        long rowId = db.insert(NOTES_TABLE_NAME, Notes.NOTE, values); 

        if (rowId > 0) { 

            Uri noteUri = ContentUris.withAppendedId( 

NotePad.Notes.CONTENT_URI, rowId); 

            getContext().getContentResolver().notifyChange(noteUri, null); 

            return noteUri; 

        } 

 

insert()方法使用其内部的 DatabaseHelper实例访问数据库，然后插入一条笔记记录。返回

的行 ID 然后会附加到 URI 上，形成一个新的 URI 并返回给调用方。 

现在，你应该已经熟悉 Android 应用程序的布局，掌握了 Notepad 以及 Android SDK 中其他

一些示例的结构。你应该能够运行这些示例并执行适当操作。接下来让我们看一下 Android 应用
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程序的整体周期。 

2.7 了解应用程序生命周期 

Android 应用程序的生命周期由系统根据用户需求、可用资源等进行严格管理。例如，用户

可能希望启动 Web 浏览器，但是否启动该应用程序最终由系统决定。尽管系统是最终的决定者，

但它会遵从一些既定的和逻辑上的原则来确定是否可以加载、暂停或停止应用程序。如果用户正

在操作一个 Activity，系统将为该应用程序提供较高的优先级。相反，如果一个 Activity 不可

见，并且系统决定必须关闭一个应用程序来释放资源，它会关闭优先级较低的应用程序。 

这与基于 Web 的 J2EE 应用程序的生命周期截然不同。J2EE 应用程序由运行它们的容器松

散地管理。例如，如果一个应用程序空闲了预先设定的时长，J2EE 容器可以从内存中删除它。

但容器通常不会根据负载或可用的资源在内存中加载和删除应用程序。J2EE 容器通常具有足够

的资源同时运行多个应用程序。而对于 Android，资源更加受限，所以 Android 必须能够更多和

更强有力地控制应用程序。 

说明 Android在独立的进程里运行每个应用程序，每个进程都有自己的虚拟机。这提供了一种

受保护的内存环境。而且，通过将应用程序隔离到独立进程中，系统可以控制哪个应用

程序具有较高优先级。例如，执行CPU密集型任务的后台进程不能阻止拨入的电话。 

应用程序生命周期的概念是逻辑上的，但 Android 应用程序在某些方面可能会使事情变得复

杂。具体来讲，Android 应用程序层次结构是面向组件和集成的。这支持实现富用户体验、流畅
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重用和轻松的应用程序集成，但却为应用程序生命周期管理器带来了不便。 

我们看一个典型场景。用户通过电话与某人通话，他需要打开一封电子邮件回答一个问题。

他转到主屏幕，打开邮件应用程序，打开电子邮件，单击邮件中的一个链接，然后从一个网页读

取股票报价来回答他朋友的问题。此场景需要 4 个应用程序：主页应用程序、通话应用程序、电

子邮件应用程序和浏览器应用程序。当用户从一个应用程序转到另一个时，他的体验是流畅的。

然而，在后台，系统会保存和恢复应用程序状态。例如，当用户单击电子邮件中的链接时，系统

在启动浏览器应用程序 Activity来加载一个 URL 之前，会保存正在运行的电子邮件的元数据。

实际上，系统在启动任何 Activity之前都会保存另一个 Activity的元数据，以便它能够返回到

该 Activity（例如，当用户取消操作时）。如果内存不足，系统将必须关闭一个运行 Activity的

进程并在必要时恢复它。 

生命周期对 Android 应用程序及其组件很重要。只有理解和处理好生命周期事件，才能构建

稳定的应用程序。运行 Android 应用程序及其组件的进程会经历各种生命周期事件，Android 提

供了回调，通过实现它们可以处理状态变化。对于初学者，需要熟悉一个 Activity 的各种生命

周期回调（参见代码清单 2-7）。 

代码清单 2-7 Activity的生命周期方法 

     protected void onCreate(Bundle savedInstanceState);  

     protected void onStart();  

      

     protected void onRestart();  

     protected void onResume();  

     protected void onPause();  

     protected void onStop();  

     protected void onDestroy();  
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代码清单 2-7 显示了 Android 在一个 Activity生命周期内调用的一组生命周期方法。一定要

理解系统在何时调用每个方法，才能确保实现稳定的应用程序。请注意，不需要对所有这些方法

都做出响应。但是，如果这样做了，一定要确保也调用了超类的相应方法。图 2-15 展示了各种

状态之间的转换。 

 

图 2-15 Activity的状态转换 

系统可以根据发生的其他事件来启动和停止 Activity。刚创建 Activity 时，Android 调用

onCreate()方法，然后总是会调用 onStart()，但调用 onStart()之前并不总是会调用 onCreate()，

因为可以在应用程序停止（调用 onStop()）之后调用 onStart()。当调用 onStart()时，Activity

对用户不可见，但稍后就会可见。在调用 onStart()之后，在 Activity处于前台且能供用户访问

时调用 onResume()。这时，用户就会与 Activity交互。 

当用户决定转到另一个 Activity 时，系统将调用当前 Activity 的 onPause()方法，然后可

能调用 onResume()或 onStop()。例如，如果用户将当前 Activity调回前台，将调用 onResume()。
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如果 Activity 变得对用户不可见，将调用 onStop()。如果 Activity 调回了前台，那么在调用

onStop()之后，将调用 onRestart()。如果 Activity位于 Activity栈中，但对用户不可见，并且

系统决定结束该 Activity，那么将调用 onDestroy()。 

上面介绍的 Activity 状态模型看起来很复杂，但你没有必要对每一种可能的场景都进行处

理。实际上，最常调用的将是 onCreate()和 onPause()。你将调用 onCreate()来为 Activity创建

用户界面。在此方法中，可以将数据绑定到部件并连接 UI 组件的任何事件处理程序。在 onPause()

方法中，你希望将关键数据持久保存到应用程序的数据存储中。onPause()方法是在系统结束应

用程序前调用的最后一个安全的方法。无法保证 onStop()和 onDestroy()会被调用，所以不要依

赖这些方法来实现关键逻辑。 

从上面的介绍中可以了解到什么？系统管理应用程序，它可以在任何时候启动、停止或恢复

应用程序组件。尽管系统控制着应用程序组件，但这些组件的运行并不是与应用程序完全隔离的。

换言之，如果系统启动了应用程序中的一个 Activity，则能够在该 Activity 中使用一种应用程

序上下文。例如，在应用程序的各种 Activity 之间，经常会共享一些全局变量。要共享全局变

量，可以扩展 android.app.Application类，然后在 onCreate()方法中初始化该全局变量（参见

代码清单 2-8）。然后，Activity和应用程序中的其他组件在执行时，可以自由访问这些引用。 

代码清单 2-8 Application类的扩展 

public class MyApplication extends Application  

{ 

    // global variable 

    private static final String myGlobalVariable; 
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    @Override 

    public void onCreate()  

    { 

        super.onCreate(); 

        //... initialize global variables here 

        myGlobalVariable = loadCacheData(); 

    } 

 

    public static String getMyGlobalVariable() { 

        return myGlobalVariable; 

    } 

 

} 

 

下一节将介绍一种有助于 Android 应用程序开发的技巧：调试。 

2.8 调试应用程序 

为第一个应用程序编写了几行代码之后，在模拟器中与应用程序交互时，你一定想知道是否

可以进行调试。Android SDK 包含大量可用于调试的工具。这些工具集成在 Eclipse IDE 中（参见

图 2-16）。 

在整个 Android 应用程序开发过程中都将看到的一个工具就是 LogCat。该工具显示

android.util.Log 、 异 常 、 System.out.println 等 发 出 的 日 志 消 息 。 尽 管 可 以 使 用

System.out.println 并且消息也会在 LogCat 窗口中显示，但对于应用程序中的日志消息，最好

使用 android.util.Log类。此类定义了我们熟悉的信息、警告和错误方法，可以在 LogCat 窗口

中进行过滤，以查看希望看到的信息。下面是 Log 命令的一个示例： 

 

Log.v("string TAG", "This is my message to write to the log"); 
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图 2-16 在开发 Android 应用程序时可以使用的调试工具 

Android SDK 还包含一个文件资源管理器工具，可以使用它来查看、拖放设备上的文件，即

使设备实际上是一个模拟器也是如此。 

可以在 Eclipse 中选择 Debug 透视图来查看这些工具。也可以在 Java 透视图中启动每个工具，

可以在 Window➤Show View➤Other➤Android 中找到这个菜单项。 

还可以获得 Android 应用程序的详细跟踪信息，只需要使用 android.os.Debug类，该类包含

开始跟踪方法（Debug.startMethodTracing()）和停止跟踪方法（Debug.stopMethodTracing()）。

Android 将在设备（或模拟器）上创建一个跟踪文件。可以将该跟踪文件复制到工作站，使用

Android SDK tools 目录中包含的 traceview 工具查看跟踪器的输出。本书后面将介绍其他工具。 

2.9 小结 

本章介绍了如何安装开发环境来构建 Android 应用程序，讨论了 Android API 的一些基本构

建块，介绍了 View、Activity、Intent、ContentProvider和 Service。然后分析了 Notepad 应用

程序中的上述构建块和应用程序组件。接下来探讨了 Android 应用程序生命周期的重要性。最后
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简单介绍了 Android SDK 的调试工具，这些工具都集成在 Eclipse IDE 中。 

本章介绍了 Android 开发的基础知识，下一章将详细介绍 ContentProvider、资源和 Intent。 

 


